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dtl ik arusmaster:  introduc tion

The diagram shows a typical
workflow based on the modules of
dtl FontMaster.

dtl IkarusMaster is an editor for the Ikarus format. Almost all of the
functionality matches that which dtl BezierMaster ouers for the bezier
format; there is a Font Administration tool, a Metrics Editor and a number
of optimisation functions. The seamless integration with the bezier editor
is not only apparent in its similarities with the interface, but also from the
fact that Ikarus data can be loaded directly into the background of dtl
BezierMaster. Consequently, the conversion of the ik format to the be
format can be fully checked. 

dtl IkarusMaster is a fantastic upgrade for the users of the earlier
editors of the Ikarus format, including Ikarus m and Ikarus d. The Ikarus
format is accepted by dtl DataMaster as input format and this makes it
possible to generate PostScript Type 1, TrueType and OpenType fonts
directly from the ik data.
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The screen dumps in this manual were
made with alternately the Mac os and
Windows versions of dtl FontMaster.

Shortcuts are displayed in the pull
down menus next to the related
function.

dtl FontMaster runs under Mac os
8.6 and higher, including Mac os x
Classic mode and under Windows
95/98, me, nt, 2000 and xp.

dtl ik arusmaster:  user interface guidelines
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User Interface Guidelines
The user interface of the modules of dtl FontMaster follow the standards
of Mac os and Windows.

The tool bar showing the functions as graphic symbols can be moved
around with the mouse to a desired place.

Function selection works as usual: if you click the mouse inside the
menu bars, for example File, you can select the functions in ‘pull down
menus’ which are displayed on the screen. Select the requested function, for
example Open …, inside the menu by selecting the item with the mouse. For
some functions shortcuts on the keyboard are also available. They are
displayed as shown at the right and can be executed without pulling down
the File menu first. 

Under Windows the combination for New for example is <Ctrl> + n,
on the Macintosh the key is P + n.

On Windows systems you can also select any function by pressing the
<Alt> key and the underlined character shown in the pulldown menu.

A summery of the shortcuts for Mac os and Windows for dtl
IkarusMaster is given at the end of this chapter.

Nomenclature
In this manual as well as in the modules we do not distinguish between
glyphs and characters. The term character is used many times to indicate an
outline description, although a character actually can be represented by
diuerent glyphs. For example the character ‘a’ can look like this:

aa•aa•aa



dtl ik arusmaster:  outline descrip tion

Outline Description
The outlines of the glyphs in the font are described by the Ikarus format.
The ik format describes an outline by either straight lines or a Cubic spline
section, which is also a third-degree polynomial. Every point of the Ikarus
format lies exactly on the contour -in contrast to the Bezier format, where
control points are located outside the contour. Therefor the ik format is
ideal for working with a digitzing tablet for input.

For a long time the Ikarus format has been the de facto standard for
creating and manipulating digital fonts, and is still in use worldwide by
specialist type design houses. These demanding customers appreciate the
high quality of the digital data combined with the system’s flexibility, its
simplicity and the speed with which fonts can be digitized, edited and
converted into other data formats.

Four diuerent type of point are available to mark the contours:

1. Start points: only one start point for each contour is allowed. The 
ideal location for a start point is at a corner. If there are no corner 
points on the contour, the second best location is at the first (in 
clockwise order) of two adjacent tangent points. If there are neither 
corner nor tangent points, the start point should be placed at an 
extreme curve point. Start points are marked in red by default. 

2. Curve points: describe curved sections of the contour, by default 
marked in dark blue. 

3. Corner points: marking a non-continuous transition between two 
straight sections, two curve sections or a curve and a straight line.

4. Tangent points: These points are marking a continuous tangential 
transition from a straight line to a curve  and vice versa. They are 
marked in light blue by default.
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Curve point

Start point (corner point)

note: The ik file format is
considered as a database
format. Currently one file

can contain up to 22000 glyphs.
Glyphs are identified by 2-byte
numbers (1–65535). The data
consists of header, contour header
and outline. There is no hinting
information in the data. For
PostScript Type 1, TrueType and
OpenType production additional
information is necessary and has
to be supplied via text files, like
ufm, afm, etc. (more info about
these text files can de found in the
appendices).

The format specification is
public and can be found in Dr.
Peter Karow’s Schrifttechnologie
(Berlin, 1992).

tip: If you use <Ctrl> +
mouse click the program

will change the label from Anchor
to Smooth Anchor point and vise
versa. Using the Change Label
function from the Function Tool
Bar makes it possible to change
straight lines into curves and vice
versa, this way adding and
removing Control points.

Tangent points are forcing tangent
continuity between the adjacent
sections.

Tangent point



The available functions of dtl IkarusMaster can operate on three diuerent
‘objects’:
– Points as described above
– Contours. Contours are consisting of several curves and/or straight lines.
They should be closed.
– Characters. These consist of zero, one, or several contours.
There is additional information for the character such as the width and the
left and right sidebearings. These values can not be edited interactively in
the Character Edit Window, but can be changed numerically in the
Character Header from the Edit menu or in the Metrics Window.

The general information about the complete font, such as the Bodysize, is
contained in the Font Header. For some parameter values it is important to
know the bodysize of the font, which usually is 15000 (in standard Ikarus
data), 1000 (in a PostScript font) or 2048 (in a TrueType font). Font Header
information can be viewed and changed with Change Font Header function
in the Edit menu.

For further information on the Ikarus format please
see also Peter Karows books on digital typography,

like Digitale Schriyen, Darstellung und formate
(Berlin, 1992).
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The character width can be edited
with the Change Character Header
function from the Edit menu.

In the Metrics Window the character
width can be altered.

The Font Header contains general
information about the complete font.
These settings are used for instance for
the v/h Guide Lines function in the
View menu and for the generation of
the ufm file.



No points selected

All points selected
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6

Selecting points
dtl IkarusMaster uses a standard mouse with one button on the Mac or
the left button of the mouse under Windows.

For some functions it is necessary to click a mouse button and at the
same time press down the <DShift> key or the <Ctrl> key. On the Mac the
command <AP> key is used.

These combinations will be referred to as <DShift>-mouse button,
<Ctrl>-mouse button or <P>-mouse button.

The arrow tool (–>), also called pointer tool, is the default function for
selecting objects like points, contours or complete characters. Clicking the
mouse button near an outline point will select this point. 

The selection will be constrained to a certain radius around the point.
This radius can be modified by the user in the Config menu. Clicking out-
side this radius will deselect all selected points.

If no point is selected while a function is executed the whole character
will be modified by default.

1. Selecting single points
To move or delete for one point you must click near the point on the screen
to select it, in other words, select by clicking. 

2. Selecting multiple points 
2.1 Collecting points

Select the first point by clicking on it. While holding down the <DShift>
key, click again on another be point to add it to the selection. You can also
deselect an already selected point by clicking on it while holding the
<DShift> key. 

2.2 Window-in Selection
You can select all points within a user-defined window. To do so, click away
from an outline point, hold down the mouse button and drag the cursor
over the points to be selected. You can add more points to the already
selected collection by pressing the <DShift> key and repeating the window
selection. The new points will be added to the already selected ones.

3. Contour Selection
To select a contour, double click near an outline point ou the requested
contour. To select additional contours click again near an outline point of
another contour while holding down the <DShift> key. To deselect a
contour click near an outline point ou the requested contour while pressing
the <DShift> key.

Arrow or
pointer tool



A glyph can also be selected by
double clicking while positioning the
pointer tool inside the contour.

The Hidden Lines function from the
Special menu.

dtl ik arusmaster:  selec tion of points/screen l ayout
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4. Character selection
To select all points of a character use the standard shortcut <Ctrl> + a.
Some of the more advanced functions, like Hidden Lines, assume that all
points are to be processed if none is selected.

Screen Layout
The dtl BezierMaster editor has the following components in the screen
layout:

1. Tool Bar
2. Character List Window
3. Character Edit Window (several windows are possible)
4. Function Tool Bar
5. Character Display Info and Preview
6. Status Bar

2 3

6

5

1
4



T

The Character List Window (top)
shows an overview of all characters in
the database. The Character Edit
Window is shown left.

dtl ik arusmaster:  menu func tions
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Menu functions
The menu functions are selected from the pulldown menus or with the
defined shortcuts from the keyboard.

The following menus are available while the Character List Window (right)
is active:

In the Character Edit Window the actual designing takes place.The
following menus are available while the Character Edit Window (below) is
active:



Before a new ik character can be
created, first a new ik font has to be
generated.

After a new ik font is generated, a
new ik character can be created.

tip: Instead of generating
a new character by

entering the appropiate be
number, the Font Administration
tool from the View menu can be
used. Double clicking with the
mouse on a cell of a particular
codepage will open the character
and add the ik number to the
database accordingly.

After a character number has been
defined, a new slot in the Character
List Window is generated.

dtl ik arusmaster:  file menu
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f i l e  m e n u

The file menu has the following functions in the pull down menu:

New (P + n) (Ctrl + n)
This function allows you to create a new font or a new character in an
already open font. 

1. New font
Generates a new ik font. You should name and save the font first.
Afterwards you insert the character number of the character in the new
font you wish to create.

2. New Character
Insert the number of the new character you wish to insert into your
currently edited font in the following dialog box.

Allowed character numbers are in the 16-bit range i.e. from 1 to 65535. 
0 (zero) is not an allowed number. Character numbers can be found in
Appendix ix: Character number listing.
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Open (P + o) (Ctrl + o)
Opens an existing font using the standard open file dialog box. After
succesfully opening the font the program will display all characters in the
Character List Window. This window can be used to select characters to be
edited by simply clicking into the small window. Several character edit
windows can be opened simultaneously.

On Windows systems there is the option to use abbreviations
(archives) for predefined directories. If a certain flag in the Windows
registry is set, the program will accept only input from archives and display
a special open dialog.

Close (P + w) (Ctrl + w)
This function works diuerently depending on which window is currently
active. If the character list window is active, it will close the font which you
are working on. If you have changed some characters, you will be asked
whether to save or not save the changes you made. All open character edit
windows will be closed too. If the character edit window is active only this
particular window will be closed.

Save (P + s) (Ctrl + s)
Saves the data to disk. It is recommend to use this function frequently to
avoid a loss of data. This function works both in the Character List
Window and the Character Edit Window.

Save as (P + DShift + s) (Ctrl + DShift + s)
This option functions diuerent depending on the active window:

1. Character Edit Window active
Saves the character you are working on to a diuerent character number in
the font database. The Character Edit Window will subsequently contain
the new character. The previously edited character will be closed without
saving the changes. 

This function can be used to duplicate characters to other positions, as
a basis to construct new characters, such as accents, from existing ones, or
simply to reposition characters.

After succesfully opening the font the
program will display all characters in
the Character List Window.

The Character List Window has
to be active for saving the font under a
diuerent name.



dtl ik arusmaster:  file menu

11

2. Character List Window active
With this function you can save the font under a new name. 

Select character
In the following dialog box you can select a character by double clicking its
number. The image of the character will be displayed as you click on the
number once. You can also enter a character number numerically or use the
arrow keys (up and down) to scroll through the character list. Double
clicking on a character in the Character List Window gives the same result.

Delete character (TBackspace) (Delete)
To delete a character, just select the character in the Character List Window
on the left side by clicking once on the character and then press the
<TBackspace> or <Delete> key.

Import eps file
Reads an eps file and converts it to ik format. For instance eps files made
with Adobe Illustrator® can be imported. The eps data will be converted to
Ikarus format and merged into the currently active Character Edit Window.

The size and positioning of the ik data is taken from the eps data and
scaled to the bodysize of the font. Please note that the eps file must have the
suzx .eps to be recognized. The eps file must also not contain multiple
layers; these have to be removed first before importing the data in the
Character Edit Window.

The numbers shown in the Select
Character dialog are, of course, the
same as in the Character List
Window.



eps Output
Glyphs can be exported individually as eps data. The same functionality is
available for groups of glyphs from the eps Output option in the Batch
menu. 

– Size of signet
The glyph(s) can be exported with unchanged size by selecting the option
like ik-Glyph. This preserves the original relation to the other glyphs in the
font database, which makes re-importing (for instance after editing in
Adobe Illustrator®) possible without any scaling. With the option
Numerical Input the bounding box can be scaled to any size measured in
millimeters.

– Screen Preview
The eps files can be provided with a tiff for screen previewing. As an
option the required resolution can be entered. The default reolution is 300
dpi. The tiff files can be compressed with Apple’s PackBits format or
leaved uncompressed, which is the default setting. 

Further options are Transparant and Allow Overwrite, which let the
program overwrite eps files with the same name. The name of the eps is
taken from the name of the database plus the Character Number.
Exporting the glyph with Character Number 302 of the h022013d named
database will result in h022013d_00302.eps. The eps files are automatically
stored in the directory that contains the used font database.

Print (P + p) (Ctrl + p)
Uses the standard printer driver print dialog. Select the number of pages
you wish to print or set the properties of the printer. These depend on the
printer you have installed.

dtl ik arusmaster:  file menu
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The ik to eps dialog ouers a number
of options for the export of eps files.

tip: To export ik glyphs
as eps data in groups, the

eps Output function in the Batch
menu can be used.

Exported eps files can be imported
for instance in Adobe Illustrator®.
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Print Setup … (P + DShift + p) (Ctrl + DShift + p)
This function allows you to change the printer and printer properties.

Print Preview 
This function works diuerently depending on which window is active.
–If the Character Edit Window is active, a printout of this character will be
generated with the selected print options and be displayed in the currently
active window as a preview.
–If the Character List Window is active all characters or the selected ones
(see File Menu –> Printing Options –> Text Options) will be prepared for
printing and the generated page will be shown in the character list window.
Since this window is quite narrow it should be enlarged to show the
complete page and all the options for the display of the preview.

Print Options (P + FAlt + p) (Ctrl + Alt + p)
These options are diuerent depending again on the active window:

1. Character Edit Window active
This function allows you to set diuerent options for proofing of 
individual characters.

1.1 Character Size (bodysize in millimeters).
1.2 Character Spacing (spacing in millimeters).
1.3 Line Spacing (line spacing in millimeters).
1.4 Filled (displays the character solid or as outline).
1.5 Print Bounding Box (shows the character bounding box).
1.6 Print Baseline & Sidebearings (shows baseline and sidebearings).
1.7 Print Digitizing Marks (shows anchor and control points).
1.8 Print em-Square (shows the em around the character).

Print previewing is possible.

A large range of print options is
available when the Character Edit
Windows is active.



A large range of print options are
available when the Character List
Window is active. The options
selected in the dialog above result in
the output shown on the ley.

dtl ik arusmaster:  file menu
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1.9 Print 2. Square (shows the facesize for Kanji).
1.10 Display Numbers (shows the character number at the 
set distance below the character).
1.11 Hexadecimal (Output of character number in hexadecimal; 
decimal is the default setting).

2. Character List Window active
This function allows to set diuerent options for proofing of several or all
characters. Additional options compared to the printing of a single
character are:

2.1 Character spacing (distance between the sidebearings of two 
characters).
2.2 Line Spacing (distance between the two lines of text).
2.3 Horizontal/vertical setting (option for Kanji setting).



Ayer selecting Text Options … in the
Printing Options dialog it is possible
to enter a text for proofing the font(s),
as shown at the ley.

(ley) In case you have chosen more
than one font to display the text, you
can display the whole text in the first
font, then in the second, the third,
etcetera. Note that the line mode will
change the Proof fonts after each line
of text, not after the complete text.

The File List, 1 …, 2 …, 3 …, 4 …,
function will show up to eight of the
most recent used files.

dtl ik arusmaster:  file menu
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2.4 TextOptions. You will see a dialog which allows the input of 
character numbers or proof text. For proof text you can select an 
existing text file or edit text in the Edit Window. You can also 
choose diuerent fonts for printing the selected text.

File list, 1 … 2 … 3 … 4 …
Select a font from up to eight font files listed in the File menu. These fonts
have been opened before and have been memorized by the program
automatically.

Exit (P + q) (Ctrl + q)
Exit the program. If unsaved data is still in memory, the program will ask
you if you would like to save these changes to disk.

On Windows you can also use the standard <Alt> + <f4> to close the 
program.



The font header contains general
information about the complete font.
These settings are used for instance for
the v/h Guide Lines function in the
View menu and for the generation of
the ufm file.

e d i t  m e n u

These options are diuerent depending on the active window:

1. Character List Window active
Change Font Header (P + DShift + f) (Ctrl + DShift + f)

Use this function to numerically change the Font Header as well as to
display the content. All values are font specific and might be used for
further format conversions. 

The Distance is the space between the baseline descender line. The
BodySize is normally the distance between the extremes of the ascender
and the descender.

dtl ik arusmaster:  edit  menu
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Hxdp
CapHeight
Ascender line

x-Height

Baseline

Descender line



Metrics Editor
This is a very powerful tool to adjust the positions and widths of characters.
The Metrics Window can be resized to take full advantage of the screen
resolution. The anti-aliased shown Characters can be selected by keystrokes
or by character (database) number. The size of the characters can be
defined by point size. 

The position of the characters can be changed by selecting and
dragging the triangle below the line that marks the Distance value in the
Font Header (normally the length of the descenders). The triangle marks
the centre of the bounding box. By default the triangle is blue but in case a
character is selected the triangle in the centre is red. Only a selected triangle
can be moved. The side bearings can be changed by dragging the blue
triangles (these don’t change colour) that mark the widths of the characters.
Always take note of the fact that moving the side bearings only auects the
width of the selected character (marked with the red triangle in the center).
The side bearings are shown if the option guidelines is selected.

Changes to the width can also be made numerically by altering the
values of the side bearings indicated by lsb (left) rsb (right). The changes
made in the Metrics Editor are saved automatically to disk. There is of
course an undo function. To prevent any errors, there is the possibility to
lock the position and the width of the shown characters.

Further options include the import and export from kerning
information from afm file or kern feature file, which for instance can be
generated both by dtl KernMaster.

dtl ik arusmaster:  edit  menu
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A red triangle in the centre (of the
bounding box) marks a selected
character.

The Metrics Editor is a powerful tool
to adjust the positions and widths of
characters.



Copying in fore- and background can
be done using shortcuts.

dtl ik arusmaster:  edit  menu
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2. Character Edit Window active

Undo (P + z) (Ctrl + z)
Undoes the last editing action. The program supports up to 50 undo levels.

Redo (P + y) (Ctrl + y)
Redoes the last editing action with the Undo function. Redo supports up
to 20 diuerent redo steps.

Undo Character Editing
Undoes all changes since the last Save.
The program will ask for a confirmation before all edits are discarded.

Cut (P + x) (Ctrl + x)
Deletes and simultaneously copies one or more selected contours to the
clipboard.

Copy (P + c) (Ctrl + c)
Copies all selected contours to the clipboard.

Paste (P + v) (Ctrl + v)
Pastes the content of the clipboard into the currently edited character at the
position which is defined as the original position plus a fixed ouset in x and
y which is currently set to 300,300 for 15000 em.

Paste (P + DShift + v) (Ctrl + DShift + v)
Pastes the content of the clipboard into the currently edited character
without ouset.

Select all points (P + a) (Ctrl + a)
Selects all points of the character.

Copy into Background (P + Ctrl + c) (Ctrl + Alt + c)
Copies the character in the foreground into the background.

Replace by Background (P + Ctrl + r) (Ctrl + Alt + r)
Replaces the character in the foreground by the character in the
background.

Paste from Background (P + Ctrl + v) (Ctrl + Alt + r)
Adds the character in the background to the character in the foreground.

Next Character (P + UKeyRight) (Ctrl + UKeyRight)
Selects the next character in the currently active character edit window 



If changes have been made to the
current character, the program will
ask whether to save these or not
before showing the next or previous
character.

In the Character Header dialog the
width and side bearings can be
numerically changed. 

The side bearings can also be
changed by selecting and dragging in
the Character Edit Window.

dtl ik arusmaster:  edit  menu
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with respect to the character number. If the currently edited character has
been modified, the program will ask if you want to save the edits.

If the background is active, the character in the background will be
changed too if the same number as used for the foreground character exists.

Previous Character (P + TKeyLeft) (Ctrl + TKeyLeft)
Selects the previous character in the currently active Character Edit
Window with respect to the character number. If the currently edited
character has been modified the program will ask whether to save the edits
or not.

If the background is active, the character in the background will be
changed too if the same number as used for the foreground character exists.

Change Character Header (P + i) (Ctrl + i)
Use this function to numerically change the left side bearing (lsb), right
side bearing (rsb) and total width (the width is calculated automatically). 

You can edit the fields on the left side. You can not edit the xMin,
xMax, yMin and yMax fields. These will be calculated automatically. 

Change Font Header (P + DShift + f) (Ctrl + DShift + f)
Use this function to numerically change the Font Header as well as to
display the content. All values are font specific and may be used for further
format conversions. 



The grid is defined in the Config
Menu: Editor functions and
colors: Grid step.

The cross cursor is an alternative for
the arrow (pointer) tool.

dtl ik arusmaster:  vie w menu
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v i e w  m e n u

This menu has diuerent options depending again on the active window. If
the Character Edit Window is active you will see the following menu
entries.

Display
In this submenu several parameters for the display can be set.

Display Marks (P + m) (Ctrl + m)
Displays the Ikarus points:
– Start points (indicated with an arrow)
– Corner points (indicated with a long line)
– Curve Points (indicated with a short line)
– Tangent points (indicated with a v-shaped line)

Fill Color (P + f) (Ctrl + f)
Use this function to switch on and ou the filled display. The colour
is set in the Config Menu: Editor functions and colors.

Grids (P + g) (Ctrl + g)
Use this function to switch on and ou a grid which is shown in the 
background. The grid can be defined in the Config Menu: Editor 
functions and colors: Grid step.

Reset (P + r) (Ctrl + r)
Resets the display to the default size. Use this function also to 
redisplay the character in case of display problems.

Cross Cursor
Use this function to switch on and ou a cross-hair cursor.



With the Horizontal Guidelines
switched on, the guidelines set in the
View menu will be shown.

dtl ik arusmaster:  vie w menu
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Digitizing Number (FAlt + d) (Alt + d)
Use this function to switch on and ou the digitizing numbers of 
the anchor and control points, corresponding to the Edit xy list.

Vertical Guidelines (DShift + v) (DShift + v)
Use this function to switch on and ou the vertical guidelines as set 
in View –> v/h Guidelines.

Horizontal Guidelines (DShift + h) (DShift + h)
Use this function to switch on and ou the horizontal guidelines as 
set in View –> v/h Guidelines.

em Square on/off (P + d) (Ctrl + d)
Use this function to switch on and ou the em square.

Background chars on/off (P + b) (Ctrl + b)
Use this function to hide and display the characters that are put 
into the background.

Second em Square on/off (P + DShift + d) (Ctrl + DShift + d)
Use this function to switch on and ou the second em square, as 
defined in the Config –> Settings menu.

Toolbar
Use this function to switch on and ou the toolbar with the file and print
icon, etc. at the top of the screen. You can use the toolbar to simply select
for example, Open or Save, by clicking on the toolbar icon. 

Status bar
Use this function to switch on and ou the status bar with the date and time
at the lower side of the screen.

Display Function bar
Use this function to switch on and ou the display functions toolbar at the
top of the screen. You can use the display functions toolbar to simply hide
or display, for example, marks and grid, by clicking on the toolbar icon.



The functions in the Function
Toolbar (top) are described in the
chapter about the Tools menu.

The horizontal guide lines for
ascender, x-height and descender are
automatically generated based on the
values in the Font Header in the Edit
menu.

dtl ik arusmaster:  vie w menu
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Function Toolbar
Use this function to switch on and ou the Function Toolbar at the right side
of the screen. You can use the Function Toolbar to simply select, for
example, shift or Zoom, by clicking on the toolbar icon . 

You can also use the construction tools, such as Circle or Rectangle,
etcetera by clicking on the toolbar icon.

Charinfo
Hides or displays an information window for the characters metrics. The
information will be shown on the right side of the screen together with a
small filled preview of the character.

The explanation of the number is as follows:

l (left side bearing; 1/ 100 mm)
cw (character width; 1/ 100 mm)
r (right side bearing; 1/ 100 mm)
tw (total width; 1/ 100 mm)
c (number of contours)
p (digitizations; number of ik points)
xMin (position of leftmost ik point)
xMax (position of rightmost ik point)
yMin (position of lowest ik point)
yMax (position of uppermost ik point)

v/h Guide Lines (P + DShift + l) (Ctrl + DShift + l)
You can determine vertical and horizontal guidelines in the following
dialog. The values for the vertical guidelines start from the left sidebearing
(lsb) of the character. After inputting a value, press the <JReturn> key. 



In the Edit Coordinates window the
coordinates can be edited
nummerically.

You can select diuerent formats (ik, ii,
be and sc) for the background. It is
possible to show ik and sc in the
background simultaneausly.

With Show background you can make
the background visible.

dtl ik arusmaster:  vie w menu
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Edit Coordinates (P + e) (Ctrl + e)
Here you can edit the coordinates of all ik points in the following submenu.
Selected points are marked in the display as well as in the list.

To shift the selected points numerically just double click on one
selected value in the Edit Coordinates window and change it to the desired
value by keyboard input. If several points are selected all points will be
modified with the same amount. Undo/redo is possible via <Ctrl> + z/y.

Select Background (P + DShift + b) (Ctrl + DShift + b)
You can select another ik character from the same font or another font as a
background character.

It is also possible to display a scanline character (from scanned input)
as background. You can select the background from the dialog shown
below.

If a background character is selected from a font database that contains
more characters, typing P + U or P + Twill show not only the next or
previous character in the foreground but also the next or previous character
from the background font. Closing the Character Edit Window will
remove the link to the background font. 

Background on/off (Ctrl + b) (Alt + b)
With this function you enable or disable the background. You can also
determine whether the outline font in the background is shown with or
without marks or modify the position of the glyphs.
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If the Character List Window is active the View menu will only display the
options Toolbar, Status Bar and Font Administration.

The Toolbar and Status Bar functions have been described in the
previous pages.

Font Administration (P + u) (Ctrl + u)
This is a very powerful tool for handling and organizing the font database.
Because allowed numbers are in the 16-bit range, the database can consist
of more than 65.000 characters. In the Font Adminstration window the
diuerent code pages that are supported by the character set in the database
can be shown beside the Unicode and the Character Numbers. It is possible
to copy and paste between the codepages. Pasted characters will be placed
in the database automatically under the appropriate number. Newly
(re)placed characters are saved automatically. Be aware that undo is not
available here!

tip: Because changes
made to the database with

the Administration Tool are
irreversible, it is recommended to
make a back up of the font first.

The current beeditor.cha file supports
the following codepages:
– Unicode
– urw-Number
– pc-West
– Mac-West
– pc -East
– Mac -East
– pc-Greek
– Mac-Greek
– pc-Turkish
– Mac-Turkish
– pc-Cyrillic
– Mac-Cyrillic
– pc-Hebrew
– Mac-Hebrew
– pc-Baltic
– Mac-Romanian
– pc-Symbol
– Mac-Symbol
– pc-Kazakh
– Mac-Kazakh



With the Font Administration tool
characters can be exchanged between
diuerent font databases.

Although characters can be copied and pasted between diuerent ik
databases in the Character Edit Window, this functionality is limited to one
character at the time. With the Font Administration tool it is possible to
copy and exchange (large) ranges of characters between diuerent databases.
To select more than one character, hold down the <DShift> key while you
select single characters or several series of characters. Characters can be
selected in serie by holding the mouse button down and simply dragging
the mouse.

The Character Edit Window can also be opened from the Font
Administration tool by double clicking on a character.
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The Character Layout Files are
placed in the same directory as the fm
modules, libraries and the other stuu.

From left to right the code pages for
Mac-West, pc-West, Mac-East, and
urw-Number.

Diuerent Character Layout Files (*.cha) can be selected. These Character
Layout Files are also used by dtl DataMaster when fonts are generated.
After installing dtl FontMaster four Character Layout Files are installed
in the same directory as the fm modules:

– beeditor.cha
This is the default Character Layout File for dtl BezierMaster.

– ttbas.cha
Basically you can ignore this Character Layout File here because normally
it will only be used in dtl DataMaster to import fonts.

– urwotf.cha
In dtl DataMaster this Character Layout File must be selected when you
want to generate OpenType. All possible OpenType features will only be
generated if this .cha file is selected.

– winuni.cha
Basically you can ignore this Character Layout File here because normally
it will only be used in dtl DataMaster to import fonts.

Currently, the beeditor.cha file supports 21 code pages. The Character
Layout Files are fully editable and more code pages can be added by the
user (see Appendix iii). 

The Number Display shows five options that can be used in combination
with the codepages:

–hex (hexadecimal notition; default for Unicode)
–urw (urw database numbers)
–ansi (default for pc codepages)
–quickdraw (default for Macintosh codepages)
–decimal (decimal notition)

Although there are some default combinations of codepages and number
displays, each possible combination can be made.
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b at c h  m e n u

This menu is only available in case the option Font Administration is
selected from the View menu. The functions in the Batch menu can also
be found in the Tools and Special menus when the Character Edit
Window is active. The big diuerence between the functionality in the
Batch menu and the other two menus is that in the Font Administration tool
several or even all characters can be selected for processing while using the
same functions in the Character Edit Window only influences the selected
character. If no glyph is selected the batch operation will be applied to all
glyphs in the database.

Please pay attention to the fact that changes are irreversible; the
operations applied to the glyphs are automatically saved on the disk.

Scale
After having selected contours or the whole character, input the scaling
factors in x and y direction in %. You can also determine the origin of the 
scaling and whether or not you will scale the sidebearings simultaneously.

Metrics
There are several options to modify the metrics by changing the widths or
sidebearings of the selected glyphs. In the Metrics dialog positiv or negative
values can be entered in the input field(s) called Values.

– Change Sidebearings absolute
The sidebearings of all the selected glyphs will get the values specified in
the two input fields for the left and right sidebearing.
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The options in the Batch menu are
only available in case the Font
Administration tool is active.

In case no glyph is selected the batch
operation will be applied to all glyphs
in the database.



– Change Sidebearings relative
The sidebearings of all the selected glyphs will be modified by the values
specified in the two input fields (for the left and right sidebearing).

– Change Sidebearings (Scale)
The sidebearings of all the selected glyphs will be scaled according to the
values specified in the input field.

– Change Width (Sym.)
The total width of all the selected glyphs will be made equal to the value in
the input field. The glyphs will be centered in the specified width, this way
making the left and the right sidebearing equal (symmetrical).

– Change Width (Proportional)
The total width of all the selected glyphs will be made equal to the value in
the input field. The left and the right sidebearings will be changed
proportionally according to the original relation between the sidebearings.

– Shift
The glyphs will be shifted in horizontal or vertical direction by the
specified amount.

Contouring
This function is used to create additional contours automatically, so called
outlined characters. It can also be used to bolden a typeface or make it
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For changing the sidebearing(s) the
dialog will show two input fields
(‘Values’): one for the left and one for
right sidebearing. For changing the
width(s) there is, of course, only one
input field available.

An example of contouring.



thinner. Input up to six values in millimetres into the Contouring dialog to
create up to the same amount of additional contours. A positive value of for
example 2 adds a contour with two millimetres distance from the original
contour to the outside. A negative value works to the inside.

– Contours
Here you can enter positive or negative values for the contouring.

– fx and fy
The creation of contours can be combined with scaling. The factors
specified for scaling in horizontal and vertical directions will be applied on
the selected glyph(s). 

– With Original Contours
In case this option is selected the original contour will be preserved. This
only works if the specified values are positive.

– Cut Corners
Selecting this option will preserve line thickness in the newly generated
contour.

– Remove Overlaps
The functionality of this option is comparable with the Union function
from the Hidden Line option and prevents overlapping contours.

Hidden Line
This function merges overlapping contours. It currently works always on
the complete character. 

– Union
Merges the contours.

– Intersection
Creates the intersection. Only the overlapping parts remain. The rest of the
contours are deleted.
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Up two six contours can be generated
using the Contouring function from
the Batch menu.

The Hidden Line dialog.
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The a on top is mirrored Left <–>
Right and the other Top <–> Bottom.

The Rotate dialog in which the angle
can be specified.

– 1-2
Deletes the second contour and the part of the first contour that was
overlapped.

– 2-1
Deletes the first contour and the part of the second contour that was
overlapped.

Mirror
This function mirrors the selected contours or the whole character. There
are two options.

Left <–> Right
This function mirrors the selected contours or the whole character
horizontally around the center of the selected parts.

Top <–> Bottom
This function mirrors the selected contours or the whole character
vertically around the center of the selected parts.

Italic
Use this function to oblique the character electronically. A special selection
mode is not required. In this function the character mode is always used.
After selecting the function a pop-up menu appears. An angle between
–45 and +45 degrees is recommended. A positive angle obliques clockwise.

Rotate
The rotate function works for selected contours or the whole character.
Input a Rotation angle; a positive angle rotates clockwise.

Merge Composites
This is an extremely powerful function that creates accented characters or
fractions or other glyphs made out of several composites. It allows a manual
parametrization or it can alternatively read and create composites from an
external text file.

Selecting the Merge Composites function will open a dialog which
shows a range of options. 

– Accent
This makes together with the options Base char. and Composites manual
parametrization possible. In the Accent input field the Character Number
of the accent is specified. For instance number 701 indicates the upper case
dieresis.



– Base char.
Here the Character Number(s) must be entered of the character(s) that
should be combined with the specified accent. Combining the character
numbers 101, 105, 115 which stand for repectively A, E and O with
Character Number 701 (Dieresis) will result in Adieresis, Edieresis and
Odieresis. Of course these newly generated characters have to be saved at
the appropriate positions. Therefore the Composites must be specified.

– Composites
Here the Character Number(s) must be entered of the character(s) that are
the result of combining the specified accent(s) with the specified base
character(s). The standard positions in a ik or be database for instance for
Adieresis, Edieresis and Odieresis are the character numbers 201, 215 and
237. The order of the specified composite Character Numbers must be
corresponding with the specified base characters. For instance base
character 101 (A) plus dieresis must result in Character Number 201
(Adieresis) in case the default Character Layout Files beeditor.cha and
urwotf.cha are used to generate fonts in dtl DataMaster. Details about the
Character Layout Files are revealed in Appendix iii. More information
about the Character Numbers can be found in Appendix ix.
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The Merge Composite dialog.

Ä
The Adieresis was generated by
combining the accent called dieresis
with Character Number 701 with base
character A, which has character
Number 101.

note: The standard places
in a ik or an be database for
the lowercase accents are in

the range 751–769. The capital
accents should be placed in the
range 701–719. Normally the
lowercase accents are positioned
in such a way that no shifting is
necessary when they are placed on
top of a lowercase character. The
same is the case for the capital
accents. It is recommended to
check first if the capital accents are
available and at the right position
before generating composite
characters.

¨
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The default text file for making
composites, accents.txt, is installed in
the dtl FontMaster directory.

A nut fraction that was automatically
generated using the Merge
Composites function from the Batch
menu.

– Adjustment
For the positioning the same options are available as for the Merge
Character function for individual glyphs from the Function menu.

Please note that it is important for merging accents to switch on the
Keep CharacterWidth option, otherwise the character width of the
composite will be diuerent from the base character depending on the
adjustement option.

– Input from file
Instead of entering all base characters, accents and composites manually
the batch mode allows the input from a text file.

This file should have the following form:

The first number is the Character Number of the new composite glyph, the
following numbers are of the glyphs which are merged, for instance
respectively of the base character and the accent.

It is allowed to specify more than two components, for example to
create fractions: 681;623;553;566. In combination with the option Center
Width and Keep CharacterWidth this series of Character Numbers creates a
nut fraction (with the Character Number 681) with the width of the first
glyph (623 = hyphen) from the three glyphs 623,553 and 566.

A default text file named accents.txt is installed in the same directory as the
other dtl FontMaster files. This text file covers all characters containing
accents for the Western and Eastern European and Turkish character sets
for Mac os and Windows.

In case the ok button has been pushed, the Font Management-Confirmation
Dialog pops up in case character numbers already exist in the database.
Always means that all existing characters with the same numbers will be
replaced. Please note that overwriting characters is irreversible. 

// URWNum;URWComp;URWComp

201;101;701

202;101;704

// URWNum;URWComp;URWComp

201;101;701

202;101;704

203;101;705

204;101;706

206;101;708

207;101;709

208;101;703

209;101;713

210;103;711

211;103;704

212;103;707

214;104;707



Replace Composites
With this function the base characters used for the composites can be
replaced by their originals. This is very useful when changes have been
made to the base characters after the generation of the composites with the
Merge Composites function. Please note that the accents are not auected and
these have to be replaced manually in case of changes made to the originals.

Selecting the Replace Composites function will open a simple dialog
which shows a small range of options.  

– Text File for Composites: Browse
Here a text file that contains composite information, like for instance the
default accents.txt, has to be selected. The second entries (after the actual
Character Numbers of the composites) in the text file will show up in the
Select Composites: part of the dialog.

– Check All Composites
This option makes it possible to replace all base characters listed in the
selected text file or, when not activated, to select individual Character
Numbers in the Select Composites: part of the dialog.

eps Output
Glyphs can be exported as eps data individually or as group. Selecting this
batch function will open the ik to eps dialog containing a range of options.
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After a text file that contains the
composite information has been
selected, the Character Numbers of
the base characters show up in the
dialog.

Glyphs can be exported as eps data
using several options.



– Size of signet
The glyph(s) can be exported with unchanged size by selecting the option
like ik-Glyph. This preserves the original relation to the other glyphs in the
font database, which makes re-importing (for instance after editing in
Adobe Illustrator®) possible without any scaling. With the option
Numerical Input the bounding box can be scaled to any size measured in
millimeters.

– Screen Preview
The eps files can be provided with a tiff for screen previewing. As an
option the required resolution can be entered. The default reolution is 300
dpi. The tiff files can be compressed with Apple’s PackBits format or
leaved uncompressed, which is the default setting. 

Further options are Transparant and Allow Overwrite, which let the
program overwrite eps files with the same name. The name of the eps is
taken from the name of the database plus the Character Number.
Exporting the glyph with Character Number 302 of the h022013d named
database will result in h022013d_00302.eps. The eps files are automatically
stored in the directory that contains the used font database.

– Character Selection
Glyphs can be exported individually as eps files but also as group. With the
option Single a Character Number can be entered. The option All will
export all the glyphs in the font as eps files. It is also possible to export
ranges using the input fields of the Group option. 

If multiple glyphs are exported by default the prgram will generate a
number of single eps files. In case one large eps file that contains all glyphs
is required, the function Put all selected ik into one eps file should be
activated.

Import (Data Management)
With this very powerful batch function glyph data can be imported in the
currently open ik database from any other ik database. It is not necesarry 
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The exported eps files are stored in
the directory that contains the used
font database.

The size of the exported eps file is
based on the bounding box of the
glyph.

The Import (Data Management)
function makes the exchange of data
between diuerent files very easy.



to actually open the other database(s) in dtl BezierMaster. This function
makes it for instance possible to build large databases from ones that
contain only single code pages, which is very useful especially with the
OpenType production in mind.

Using the default Character Layout File beeditor.cha when importing
for instance PostScript Type 1 fonts in dtl DataMaster will place the lower
case characters in the Character Number range 301–326. The same will
happen when a Small Caps font is imported because of the used PostScript
names for the characters. However, the ‘real’ names of the small caps are
not a,b,c, etc. but Asmall, Bsmall, Csmall, etc. The corresponding
Character Numbers in the beeditor.cha are 4301, 4302 and 4303. By simply
entering the range 301–326 in the Input Groups input field and entering 4301
in the input field of Target Groups, the small caps will placed in the correct
positions in the database, which correspondents with the appropriate
PostScript names and Unicode numbers.

– Import from:
Here the ik database has to be entered from which glyphs have to be
imported in the currently active font in the Font Administration tool. You
can browse to select the database. 

Activating the All glyphs option will import all the characters from the
selected database. If the Glyph group(s): has been activated subsequently
the range(s) of the Input Groups and the Target Groups have to be defined. In
the input filed of Input Groups the first and last Character Number has to be
given divided by a hyphen. For the Target Groups only the first Character
Number has to be entered. Comma’s are used between multiple groups.
For example: the groups 101-110, 301-310 entered in the Input Groups section
can be placed at the Target Groups 4101,4301. There is basically no limit to
the number of groups defined.

If the Supersede existing Characters check box has been activated,
existing glyphs with the same Character Numbers as entered in the Target
Groups input field, will be overwritten. Please pay attention to the fact that
these changes are irreverible!

In case the bodysize of the two databases are diuerent, you will be
asked whether to scale or not the glyphs to the bodysize of the target
database.
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The default setting for the Character
Layout File in dtl DataMaster will
let the program use the beeditor.cha
file when PostScript Type 1 and
TrueType fonts are converted to the ik
format. For OpenType fonts the
urwotf.cha file is used by default.

Glyphs can be imported in single or
multiple groups.



tip: Several of the
functions from the Tools

menu, that work in the Character
Edit Window only for the active
character, can be used for a (large)
range of characters using the
Batch menu in combination with
the Font Administration tool.
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t o o l s  m e n u

The functions in the Tools menu can be chosen either from the pulldown
menu or from the Function Toolbar. Moving the mouse slowly across the
toolbar automatically displays an explanation of the icon. Some functions
can also be chosen via keyboard shortcuts. The abbreviations are shown in
the pulldown menu on the right side, for example <Alt> + a keys to select
the arrow (pointer) tool.

Arrow (Space) (FAlt + a) (Alt + a)
The arrow or pointer tool is the standard tool to select one or more points
or contours as explained in the selection rules:
– Clicking near a point selects this point.
– <DShift>+ mouse click adds a point to the selection.
– A mouse click far away from any point deselects everything.
– A selection with a rectangle can be made by holding down the mouse
button and dragging it across the desired area.
– A contour can be selected by double clicking on it.
– A glyph can be selected by double clicking inside it.



dtl ik arusmaster:  tool s menu

37

The selected objects can be shifted easily with the arrow tool. Move the 
arrow near one of the selected objects, press the mouse button, hold it
down and move it to the desired position. The objects will be shifted to that
position.

Move Screen (w) (w)
This function allows you to shift the visible display of the currently edited
character within the window. It is equivalent to scrolling using the standard
scrollbars, but more conveniently.

Zoom +,– (e) (e)
Selecting this function changes the cursor to a looking-glass symbol. You
can use it to enlarge or reduce the display. 
Zoom (+) Click the mouse button enlarges the display in small steps. 
Zoom (-) <DShift>-mouse click reduces the display in small steps.
Holding down the mouse button and dragging the mouse opens a
rectangle. If you enlarge the display this rectangle will be the viewable area
if the mouse button is released again. If you hold the <DShift> key while
dragging the mouse, the currently visible area will be displayed in the
rectangle generated by the mouse. Reset (P + r) will restore the default
image size. The zoomfactor can be set in the Config menu.

Delete Point (DShift + 1) (DShift + 1)
With this function, if you click on an anchor point, it will be deleted
immediately. If the anchor point delimites two Bezier curve sections the
neighbouring control points will be deleted as well. If you click on a control
point both control points of a Bezier section will be deleted. 

Points can be shifted with the T and
U keys also. The Step Shift units can
be defined in the Config menu.
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Insert Point (DShift + 2) (DShift + 2)
Click the mouse near the contour to insert a point. By default a curve point
will be inserted. <DShift>-mouse click will result in a corner point. <Ctrl>-
mouse click produces a tangent point.

Change Label (DShift + 3) (DShift + 3)
This function can also be used to toggle between curve, corner and tangent
points. If you use <Ctrl> + mouse click the program will change the label
from curve to corner to tangent point and vice versa. 

Measurement (Ctrl + s) (Alt + s)
This function can measure the distance between two outline points by
simply clicking on them with the mouse. The result will be shown in a small
popup window on the screen. You can make the measurement window
disappear by selecting another function like Arrow.

The measurement window displays the coordinates, the nature (start,
curve, corner, tangent). The same information is displayed for the last point
which was clicked with the mouse (denoted as ‘Another Point’).
You will also see the distance of these two points in x and y, the complete
euclidian distance and the angle between these points.

If you click far away from any outline point the screen display position
will be displayed and no information about point number etcetera is shown.

The Delete Point function in action.

For measuring the distance between
two points, select a point with a
mouseclick and repeat this with
another point.



Moving the mouse into the
rectangle that marks the ik
background will change the
cursor into a four-arrow
shape. With this cursor
activated, the background can
be moved. Selecting one of the
eight points that mark the
background rectangle will
change the cursor into a two
arrow variation. With this
cursor activated, it is possible
to resize the background.

Changes made in the
background are irreversable.
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Shift Smooth (Ctrl + x) (Alt + x)
This function can be used to move points. The point will be shifted such
that tangent continuity is preserved. This means that the adjacent points are
shifted too

Scale or Shift sc Background 
Using this function you can scroll the sc background to a desired position.
After selecting this function, a scalable rectangle will appear which you can
move on the screen to the desired position. 

Scale or Shift ik Background
Using this function you can scroll and scale the ik background to a desired
position and size. You have to set the be background first in the View menu.
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Adjust Baseline
This function is designed to align logos or letters which are automatically
converted from scanner data into outline data. It is not possible to align a
logo 100 % vertically or horizontally by hand on a scanner. Use this
function to align a logo to two outline points. The function will rotate the
character so that the two selected points are either horizontal or vertical
after the rotation, depending on the angle of the original points. After
selecting this function, click on the first anchor or control point and then on
the second one.

Pen Tool (Ctrl + q) (Alt + q)
With this function you can draw contours by directly placing points with
the mouse in the Character Edit Window. By just clicking and immediately
releasing the mouse button, only curve points will be placed. While holding
down the <DShift> key and clicking the mouse, the points will be
connected by straight lines in vertical or horizontal direction with
exception of the line that closes the contour. <Ctrl>-mouse click produces a
tangent point. This function makes a perfect combination with the Change
Label function.

1

2

For aligning a logo or character, just
select one point (in this case a point
on the left serif of the a) and select a
second point (right serif of the a).

The variations of the shape were
made with the Change Label
function.



Disconnecting is very easy; just select
a point with the mouse and
consequently select another point.
Two closed contours will be generated
automatically. In the illustrations this
action is repeated until all three serifs
could be removed.

It is possible to build a database of
serifs that for instance can be
connected numerically to the stems
using the Merge Character and
Hidden Lines functions.

i - Disconnection
This is a powerfull function to cut a single contour is into two contours
with an overlap. Especially in combination with the Hidden Line function,
the i-Disconnection function can be of great value for font production. For
instance, a database of diuerent serifs can be built and connected to the
stems at a later stage of the production.

The selection of the location of the cut can be done by selecting two ik
points (the function is executed immediately after having clicked onto the
second ik point) or by dragging the mouse by holding the left mouse button
down over the contour part which has to be separated. The function is
executed immediately after having released the mouse button.

The overlap is set in the Disconector Overlap (units) option in the
Config menu.
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The center of rotation is by default
the center of the bounding box (1) but
can be placed anywhere else (2). The
rotation at the right was made with
the second center.
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Fit Point to guide line
Using this function, you fit a point ot the nearest horizontal or vertical
guideline. Currently not implemented.

Rotate (Ctrl + z) (Alt + z)
Using this function, you can rotate selected contours or the complete
character around a defined center of rotation. Set the center of rotation
with the mouse. The default setting is the center of the bounding box but
you can place the center of rotation practically everywhere. Changing
functions in the Function Toolbar wil restore the default position. To rotate
the character click on the edges of the rectangle and move the mouse.

Scaling (Ctrl + w) (Alt + w)
With this function you change the size of characters, contours or contour
groups. It is also possible to select individual points. In general scaling can 
be done either using the mouse or a numerical input via the keyboard.

The selection of this function generates a rectangle around the selected
points. You can then either scale or shift this rectangle depending on the
way you drag the mouse. Selecting certain magic points of this rectangle
enables diuerent funtions:

– Diagonally to the upper left side
– Vertically to the upper side
– Diagonally to the upper right side
– Horizontally to the left side
– Central equal to all sides
– Horizontally to the right side

1

2



After selecting the points, objects can
be scaled in several directions.

If the direction of the inner contour is
not properly set, it will be filled also
(left). After changing the sense of
rotation this problem will be solved

– Vertically to the lower side
– Diagonally to the lower right side

After the direction and factor of the scaling have been selected, execute the
function finally by clicking again. 

Change Sense of Rotation
This function allows you to change the path direction of a contour. Just click
on an outline point of a contour to change its sense of rotation. Changing
the sense of rotation auects the fill of inner and outer contours.
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The number of corners of the Polygon
and Star functions can be set in the
Settings function of the Config
menu.

Circle
This function allows you to create a circle. Select the function, click at a 
position you wish and drag the mouse. The circle will be generated on the
fly and can be changed as long as you hold the mouse button pressed.

Rectangle
This function allows you to construct a rectangle. It will be generated on
the fly and can be changed as long as you hold down the mouse button.

Tri-Edge
This function allows you to construct a triangle. Select the function, click at
a position you wish and drag the mouse. The triangle will be generated on
the fly and can be changed as long as you hold down the mouse button.

Polyline
This function allows you to construct a polygon. The number of corners for
a Polygon can be set in the Settings function of the Config menu. Select the
function, click at a position you wish and drag the mouse. The polygon will
be generated on the fly and can be changed as long as you hold down the
mouse button.

Star
This function allows you to construct a star. The number of corners for a
star can be set in the Settings function of the Config menu. Select the
function, click at a position you wish and drag the mouse. The star will be
generated on the fly and can be changed as long as you hold down the
mouse button.

Ellipsis
This function allows you to create an ellipsis. Select the function, click at a
position you wish and drag the mouse. The ellipsis will be generated on the
fly and can be changed as long as you press the mouse button.

dtl ik arusmaster:  tool s menu

44



The a on top is mirrored Left <–>
Right and the other Top <–> Bottom.

The smallcaps a in this example was
slanted to the right.

The smallcaps a in this example was
shifted over the x- and y-axes.

f u n c t i o n  m e n u

Mirror Left <–> Right
This function mirrors the selected contours or the whole character
horizontally around the center of the selected parts.

Mirror Top <–> Bottom
This function mirrors the selected contours or the whole character
vertically around the center of the selected parts.

Numeric
Several functions can also be used with numerical input: Italic, Shift, Scale,
Rotate. Select the contours to be modified, choose the numeric function,
for example Scale, and then fill in the numeric values (your desired
parameters) into the pop-up window, which will appear on the screen.

– Italic
Use this function to slant the character electronically. A special selection
mode is not required. In this funtion the character mode is always used.
After selecting the function a pop-up menu appears. An angle between
–45 and +45 degrees is recommended. A positive angle slants to the right.

– Shift
This function works on all levels, for selected points, contours or the
complete character. 
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The SmallCaps a in this example was
slanted nine degrees.

The smallcaps a in this example was
scaled 110 % for the x and y factors
with the option ‘coordinate origin’
selected.

The smallcaps a in this example was
rotated ten degrees clockwise.

– Scale
After having selected contours or the whole character, input the scaling
factors in x and y direction in %. You can also determine the origin of the 
scaling and whether or not you will scale the sidebearings simultaneously.

– Rotate
The rotate function works for selected contours or the whole character.
Input a value in Rotation angle: a positive angle rotates clockwise.

Merge Character
This function allows you to merge another character with the currently
edited one. To do so you select this menu option. It allows to select a
typeface, from which you can copy a character into your current character.
You must select the character number in this typeface and afterwards fix
the position for merging.

The dialog box allows diuerent options for adjustment, which might be
used for diuerent purposes like merging accents or creating fractions or
other composite characters. The options are:
– Left side bearing (lsb) / left side bearing (lsb)
– Right side bearing (rsb) / right side bearing (rsb)
– Left side bearing (lsb) / right side bearing (rsb)
– Right side bearing (rsb) / left side bearing (lsb)
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The Merge Character function can
for instance be used to place accents.

tip: The merge Character
function works only for

the active Character Edit
Window. To add accents to more
than one character the Merge
Composites function from Batch
menu can be used in combination
with a text file that describes
which glyphs have to be combined.

There are several options in the
Setting Text dialog for controlling the
output in the Character Edit
Window.

– Center Width (center in the Bounding Box)
– Center Total Width (center between the sidebearings)
– Numeric: x, y

Furthermore there are the options y-ouset and Keep CharacterWidth.

Be aware that to preserve the width of the base character the Keep
CharacterWidth option must be switched on, otherwise the width of the
composite character will diuer from the original.

Set Text
With this function text can be set in the Character Edit Window. Any ik
database can be chosen and a range of options is available to control the
output. This function is especially useful for the creation of logos.
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s p e c i a l  m e n u

The pulldown menu shows the following options.

Find Self-Overlapped Contour 
The location of this function has been moved into ‘Improve points’ in this
menu.

Hidden Line (P + h) (Ctrl + h)
This function, which is also could have been named Remove overlap, merges
overlapping contours. It currently works always on the complete character. 

– Union
Merges the contours.

– Intersection
Creates the intersection. Only the overlapping parts remain. The rest of the
contours are deleted.

– 1-2
Deletes the second contour and the part of the first contour that was
overlapped.

æ
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The ‘Union’ option merges the
overlapping contours



– 2-1
Deletes the first contour and the part of the second contour that was
overlapped.

Contouring
This function is used to create additional contours automatically, so-called
outlined characters. It can also be used to bolden a typeface or make it
thinner. Input up to 6 values in mm into the menu to create up to 6
additional contours. A positive value of for example 2 adds a contour with
2 mm distance from the original contour to the outside. A negative value
works to the inside.

Improve Points (P + i) (Ctrl + i)
This function improves the Ikarus outline if necessary. Certain problematic
digitization features can be removed and corrected, as listed in the popup
menu below. You can specify certain parameters which govern the
determination of the digitization errors.

– Display flat curves
Shows curve points which can only be regarded as straight from the Ikarus
algorithm. These curve points are marked with a blue circle.
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Up two six contours can be generated
using the Contouring function from
the Special menu.

Two examples of contouring. The
outline of the capital R was made
with diuerent values for the horizon-
tal (slightly thinner) and the vertical
lines.



tip: The Improve Points
function works only for

the active Character Edit
Window. To check and improve
all characters of a font database
dtl ContourMaster can be used.
The options in this programme
are comparable to these in the
Improve Points function.

– Display empty contours
Shows contours, which consist out of less than four digitizations. The start
point of such a contour is marked with an olive square.

– Display tiny contours
Shows contours, which areas are smaller than the tiny tolerance. The start
point of such a contour is marked with a fair brown square.

– Display double contours
Shows pairs of contours, which digitizations are nearly identical. This kind
of mistake is sometimes produced during manual digitization. All
digitizations of such contour pairs are marked with dark red circles.

– Display overlapping contours
Shows the overlap of overlapping contours. The overlaps of such contours
are marked with a violet square.

– Display self-overlapping contours
Shows overlap within a single contour. The overlaps of such contours are
marked with a red square.

– Display peaks
Shows peaks (edge points) whose angle is smaller than the peaks tolerance.
The peaks are marked with a fair brown square. A recommended value is
ten degrees.

– Display zigzags
Shows parts of the contour which have the shape of a zigzag smaller than
the double points tolerance. This kind of mistake is sometimes produced
during manual digitization. The zigzags are marked with a yellow square.

– Display snails
Shows contours where the digitization goes further than the start/end
point. This kind of mistake is sometimes produced during manual
digitization Such contours are marked with a fair red square at the position
of the start point.

– Re-distribute curve points
Tries to re-distribute the curve points in curves, so that the tangents
between them are 30 degrees. There is no marking.

– Re-sequence of contours
Sorts the contours regarding the ik rules, which means outer contours get a
lower contour number than the inner ones. There is no marking. Re-
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– Close open contours
This function closes open contours. After correction of such a contour a
green circle will mark the start point.

– Set extreme points
Moves curve points, which are located near an extreme point onto the exact
position of the extremum. If there is no curve point within the extrema
tolerance, a new curve point will be inserted onto the extremum. There is
no marking.

– Delete single start points
Deletes start points which are the only digitization of its ‘contour’. A blue
circle will mark the (former) position of the deleted start point.

– Connect aligned lines
This function checks two connected straight lines and unifies them to one
straight line, if they only diuer within the channel tolerance and within an
angle of ten degrees. A brown circle marks the position of the deleted point.

– Check narrow points (same label)
Deletes one of two neighbored ik points (the one with the higher
digitization number) of the same label in case the two points are located
closer to each other than the double points tolerance. An olive circle will
mark the (former) position of the deleted point.

– Check narrow points (different label)
Deletes one of two neighbored ik points (the one with the higher
digitization number) of any diuering label in case the two points are located
closer to each other than the double points tolerance. An olive circle will
mark the (former) position of the deleted point.

– Correct start point
Corrects wrongly located start points. This kind of mistake is sometimes
produced during manual digitization. There is no marking.

– Correct single tangent points
Converts tangent points without edge or tangent as neighbor into a curve
or edge point, depending on the neighbors. A fair-violet circle will mark the
position of the point with the changed label.

– Correct sense of rotation
Corrects the sense of rotation of contours, which means outer contours
will turn clockwise and inner ones will turn counter-clockwise. A fair-red
circle will mark the position of the start point of the corrected contour.
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c o n f ı g  m e n u

Function Settings: Parameters
In the Config menu Function Settings: Parameters you can set diuerent
parameters:

Function Default value
Disconnector Overlap 100 (units, 1/100 mm)
Cursor Sensitivity 10 (units, 1/100 mm)
Zoom 2 (factor)
Grid size 300 (units, 1/100 mm)
Step Shift 15 (units, 1/100 mm)

Please adjust these parameters if the bodysize of your font is not 15000
(units), which is the default setting. The basic idea behind the 15000 units
is, that a high resolution of the database means a greater control over the
details in the design and also a relatively small loss of quality when the
resolution is scalled down for the generation of PostScript Type 1 and
OpenType (cff) fonts (1000 units) or TrueType fonts and OpenType (ttf)
fonts (2048 units). 

The construction parameters determine the number of corners of a
polygon and a star.

If the Coordinate popup option is enabled, then the coordinates of the point
nearest to the cursor will be shown in the Character Edit Window.
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If the Coordinate popup option is
enabled, the coordinates of the point
nearest to the cursor will be shown.



Function Settings: Color
In the Config menu Settings: Color you can set the colors and the guidelines
which shall be shown or not.
The meaning is mostly self-explaining:
x minimum / x maximum
y minimum / y maximum
Base Line (at y position: 0)
Grids (Grid distance can be set in the Parameters menu above)
lsb / rsb line = Left side bearing / Right side bearing
em-size (standard ik-bodysize = 15000 (1/100 mm))
Cross Cursor (shows a crosshair cursor instead of an arrow)

Marks: Colors (default)
Start point red
Corner point = Anchor point green
Curve point = Control point blue
Tangent point = Smooth Anchor point red
Outline color black
sc background red
Selected point grey
Fit to guide grey
Self-overlap grey
ik background yellow
Preview Text Color black
Preview Background Color white

Just double click on the colors to change them.
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w i n d o w  m e n u

Cascade
When more than one Character Edit Window is opened, they overlap each
other. By choosing Cascade they are ordered in cascading windows that can
be moved to the foreground by clicking them.

Tile (P + J) (Ctrl + J)
By choosing Tile all opened Character Edit Windows are placed in a tile
pattern.

Close all windows
When this function is chosen, all Character Edit Windows are closed. The
Character List Window remains opened.
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Function

Arrow
Background on/ou
Background chars 

on/ou
Change Character
Header
Change Font Header
Change Label
Close
Copy
Copy into Background
Cut
Delete character
Delete Point
Digitizing Number
Display Marks
Edit Coordinates
em Square on/ou
Exit
Fill Color
Font Administration
Grids
Hidden Line
Horizontal Guidelines
Improve points
Insert Point
Measurement
Metrics Editor
Move Screen
New
Next Character
Open
Paste (with ouset)
Paste (without ouset)
Paste from Back-

ground
Pen Tool
Previous Character
Print
Print Options
Print Setup …
Redo

Mac os

(Space) (FAlt + a)
(Ctrl + b)

(P + b)

(P + i)
(P + DShift + f)
(DShift + 3)
(P + w)
(P + c)
(P + Ctrl + c)
(P + x)
(TBackspace)
(DShift + 1)
(FAlt + d)
(P + m)
(P + e)
(P + d)
(P + q)
(P + f)
(P + u)
(P + g)
(P + h)
(DShift + h)
(P + i)
(DShift + 2)
(Ctrl + s)
(P + k)
(w) 
(P + n)
(P + UKeyRight)
(P + o)
(P + v)
(P + DShift + v) 

(P + Ctrl + v)
(Ctrl + q)
(P + TKeyLeft)
(P + p)
(P + FAlt + p)
(P + DShift + p)
(P + y)

Windows

(Space) (Alt + a)
(Alt + b)

(Ctrl + b)

(Ctrl + i)
(Ctrl + DShift + f)
(DShift + 3)
(Ctrl + w)
(Ctrl + c)
(Ctrl + Alt + c)
(Ctrl + x)
(Delete)
(DShift + 1)
(Alt + d)
(Ctrl + m)
(Ctrl + e)
(Ctrl + d)
(Ctrl + q)
(Ctrl + f)
(Ctrl + u)
(Ctrl + g)
(Ctrl + h)
(DShift + h)
(Ctrl + i)
(DShift + 2)
(Alt + s)
(Ctrl + k)
(w)
(Ctrl + n)
(Ctrl + UKeyRight)
(Ctrl + o)
(Ctrl + v)
(Ctrl + DShift + v)

(Ctrl + Alt + v)
(Alt + q)
(Ctrl + TKeyLeft)
(Ctrl + p) 
(Ctrl + Alt + p)
(Ctrl + DShift + p)
(Ctrl + y)
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Function

Replace by Back-
ground

Reset
Rotate
Save
Save as
Scaling
Second em Square 

on/ou
Select all points
Select Background
Shift smooth
Tile
Undo
Vertical Guidelines
v/h Guide Lines
Zoom +,– 

Mac os

(P + Ctrl + r)
(P + r)
(Ctrl + z)
(P + s)
(P + DShift + s)
(Ctrl + w)

(P + DShift + d)
(P + a)
(P + DShift + b)
(Ctrl + x)
(P + J)
(P + z)
(DShift + v)
(P + DShift + l)
(e)

Windows

(Ctrl + Alt + r)
(Ctrl + r)
(Alt + z)
(Ctrl + s)
(Ctrl + DShift + s)
(Alt + w)

(Ctrl + DShift + d)
(Ctrl + a)
(Ctrl + DShift + b)
(Alt + x)
(Ctrl + J)
(Ctrl + z)
(DShift + v)
(Ctrl + DShift + l)
(e)
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